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1. Wazne

Ten elektroniczny podrecznik uzytkownika jest
przeznaczony dla wszystkich uzytkownikdw
monitora Philips. Nalezy poswieci¢ troche czasu
na przeczytanie tego podrecznika uzytkownika,

przed rozpoczeciem uzywania monitora. Zawiera
on wazne informacje i uwagi dotyczace uzywania

monitora.

Produkt firmy Philips jest objety gwarancja
pod warunkiem wiasciwej obstugi i uzywania
go zgodnie z przeznaczeniem i z wkadciwymi
instrukcjami obstugi oraz po przedstawieniu
oryginatu faktury lub paragonu kasowego,

zawierajacego date zakupu, nazwe dostawcy oraz

model i numer seryjny produktu.

1.1 Srodki bezpieczenstwa i
konserwacja

) Ostrzezenia
Uzywanie elementéw sterowania, regulacji lub

innych procedur niz te, ktdre opisano w niniejszej

dokumentacji, moze spowodowac porazenie
pradem i/lub zagrozenia mechaniczne.

Podczas podiaczania i uzytkowania twojego
monitora komputerowego nalezy przeczytac
instrukcje i postepowac zgodnie z nimi.

Dziatanie

* Monitor nalezy chroni¢ przed
bezposrednim $wiattem stonecznym,
bardzo silnym, jasnym $wiattem i trzymac
go z dala od Zrddta ciepta. Dtugotrwata
ekspozycja na tego rodzaju Srodowisko,
moze spowodowac rozbarwienie i
uszkodzenie monitora.

*  Nalezy usunac jakiekolwiek obiekty, ktére
moga blokowad szczeliny wentylacyjne
lub uniemozliwi¢ prawidtowe chtodzenie
elementdéw elektronicznych monitora.

* Nie wolno blokowac¢ szczelin
wentylacyjnych obudowy.

* Podczas ustawiania monitora nalezy
upewnic sig, ze zapewniony jest tatwy
dostep do wtyki i gniazda zasilania.

e Jesdli monitor zostat wytaczony poprzez

odtaczenie kabla zasilajacego lub przewodu

pradu statego, w celu uzyskania normalnego
dziatania, nalezy zaczekac¢ 6 sekund przed
ponownym podtaczeniem kabla zasilajacego
lub przewodu pradu statego.

*  Przez caty czas eksploatacji monitora,
nalezy uzywac przewoddw zasilajacych z
certyfikatem, dostarczonych przez firme
Philips. Brak przewodu zasilajacego nalezy
zgtosi¢ do lokalnego punktu serwisowego.
(Sprawdz informacje w cze$ci Centrum
informacji opieki nad klientem)

* W czasie dziafania nie nalezy narazac
monitora na silne drgania lub uderzenia.

* Podczas dziatania lub przenoszenia nie
nalezy uderzac lub dopuszcza¢ do upadku
monitora.

Konserwacja

*  Aby chroni¢ monitor przed mozliwym
uszkodzeniem nie nalezy nadmiernie
naciska¢ na panel LCD. Podczas
przenoszenia monitora, przy podnoszeniu
nalezy chwytac za rame; nie nalezy
podnosi¢ monitora umieszczajac rece lub
palce na panelu LCD.

* Jesdli monitor nie bedzie uzywany w
dtuzszym okresie czasu, nalezy go odtaczyé
od zasilania.

*  Przed czyszczeniem lekko zwilzong szmatka
nalezy odfaczy¢ monitor od zasilania.
Ekran mozna wyciera¢ sucha szmatka, przy
wytaczonym zasilaniu. Jednakze, nigdy nie
nalezy uzywac do czyszczenia monitora
rozpuszczalnikdw organicznych, takich jak
alkohol lub opartych na amoniaku ptyndw.

*  Aby unikna¢ ryzyka porazenia lub trwatego
uszkodzenia zestawu, nie nalezy naraza¢
monitora na dziatanie kurzu, deszczu, wody,
lub nadmiernej wilgoci.

*  Po zamoczeniu monitora, nalezy go jak
najszybciej wytrze¢ sucha szmatka.

*  Jedli do wnetrza monitora przedostanie si¢
obca substancja lub woda, nalezy natychmiast
wylaczy¢ zasilanie i odfaczy¢ przewdd
zasilajacy. Nastepnie, nalezy usuna¢ obca
substancje lub wode i wysta¢ monitor do
punktu naprawczego.

*  Nie nalezy przechowywac lub uzywac
monitora w miejscach narazonych na
oddziatywanie ciepta, bezposredniego
Swiatta stonecznego lub ekstremalnie niskich
temperatur.



* Aby zapewni¢ najlepsze funkcjonowanie
monitora i jego dtuga zywotnos¢ nalezy
go uzywadé w miejscach, w ktdrych
temperatura i wilgotnos$¢ miesci sie w
podanym zakresie.

*  Temperatura: 0 - 40°C 32 - 95°F
*  Wilgotnos¢: 20 - 80% RH

*  WAZNE: Po pozostawieniu monitora
bez nadzoru nalezy zawsze uaktywniaé
program wygaszacza ekranu z ruchomym
obrazem. Aby zapobiec pozostawaniu
na monitorze trwatego, statycznego
obrazu nalezy zawsze uaktywnia¢ aplikacje
do okresowego ods$wiezania ekranu.
Wydtuzone nieprzerwane wyswietlanie
statych lub nieruchomych obrazéw, moze
spowodowac na ekranie "wypalenie", znane
réowniez jako "powidok" lub "poobraz".

"Wypalenie", "poobraz" lub "powidok"
to dobrze znane zjawisko dotyczace
technologii LCD. W wiekszosci
przypadkdw, "wypalenie" lub "powidok”
albo "poobraz" znika stopniowo po
pewnym czasie od wytaczenia zasilania.

@ Ostrzezenie

Nie uaktywnianie wygaszacza ekranu lub

aplikacji okresowego odéwiezania ekranu, moze
spowodowac powazne symptomy “‘wypalenia”
lub “poobrazu” albo “powidoku”, ktdre nie znikna
i nie mozna bedzie ich naprawi¢. VWspomniane
powyzej uszkodzenie nie jest objete gwarancja.

Serwis

* Pokrywe obudowy moze otwierac
wyfacznie wykwalifikowany personel
serwisu.

*  Jesli wymagane sa jakiekolwiek dokumenty
dotyczace naprawy lub integracji nalezy
sie skontaktowac z lokalnym punktem
serwisowym. (sprawdz rozdziat "Centrum
informagji klienta")

* Informacje dotyczace transportu, mozna
uzyskaé w czesci "Specyfikacje techniczne".

* Nie wolno pozostawia¢ monitora w
samochodzie/bagazniku nagrzewanym
bezposrednimi promieniami storica.

(=) Uwaga

Jesli monitor nie dziata normalnie, lub gdy nie
ma pewnosci, ktdra procedure zastosowad
podczas wykonywania instrukgji dziatania nalezy
skontaktowac sie z technikiem serwisu.

1.2 Konwencje zapisu

Konwencje zapisu zastosowane w niniejszym
dokumencie wykorzystuja nastepujace elementy:

Uwagi, przestrogi i ostrzezenia

W tej instrukeji pewne bloki tekstu moga by¢
wyrdznione poprzez zastosowanie pogrubienia
lub pochylenia czcionki, moga tez towarzyszy¢
im ikony. Bloki takie zawierajg uwagi, przestrogi
lub ostrzezenia. Sg one wykorzystywane w
nastepujacy sposob:

€& Uwaga

Ta ikona wskazuje wazna informacje i porade,
pomocng W lepszym wykorzystaniu mozliwosci
sprzetu.

@ Przestroga

Ta ikona wskazuje informacje, jak uniknac¢
potencjalnego uszkodzenia sprzetu lub utraty
danych.

) Ostrzezenie

Ta ikona wskazuje mozliwos$¢ powstania
zagrozenia dla zdrowia lub Zycia oraz wskazuje
sposdb uniknigcia problemu.

Niektdre ostrzezenia moga mie¢ inng forme oraz
wystepowac bez ikon.W takich przypadkach
okreslony sposdb prezentacji ostrzezenia jest
wskazywany przez odpowiednie przepisy.



1.3 Usuwanie produktu i materiatow
opakowania

Utylizacja odpadow elektrycznych i
elektronicznych

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of

making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



http://www.philips.com/about/sustainability/recycling
http://www.philips.com/about/sustainability/recycling

. . . Instalacj dst:
2. Ustawienia monitora EX Instalacja podstawy

1. Monitor nalezy umiesci¢ ekranem w dot
na miekkiej i gtadkiej powierzchni uwazajac,
aby unikna¢ porysowan lub uszkodzenia
ekranu.

2.1 Instalacja

El Zawarto$é opakowania

Quick
Start
: LL - = 2. Przytrzymaj podstawe obydwiema rekami
i pewnie wstaw wspornik podstawy na
— kolumne podstawy.

(1) Delikatnie zatéz podstawe na kolumne
podstawy, az do zatrzasniecia zaczepow
w podstawie.

(2) Dokrec palcami $rubg na spodzie

podstawy i przymocuj dobrze podstawe
do kolumny.

& ‘
VGA (opcjonalny) VI (opcjonalny)

& Uwaga

Nalezy uzywac wytacznie model adaptera prad
zmienny/prad staty: Philips ADPC1245(227E4
QHAD), ADPC1236(227E4 LSB/LHSB/LHAB,
22784 QSD/QHSD)




El Podtaczanie do komputera PC
Model 227E4QSD, 227E4LSB:

© \Vejicie zasilania prad zmienny/prad staty

O \Wejicie VGA

O e ejScie DVI-D

© Blokada Kensington zabezpieczenia przed
kradzieza

Model 227E4QHAD, 227E4LHAB:

pu
S

© \Vejicie zasilania prad zmienny/prad staty

© \Wejicie VGA

O Wejicie HDMI

O \Wyjicie stuchawek

© \WVejicie audio

0 Biokada Kensington zabezpieczenia przed
kradzieza

Model 227E4QHSD, 227E4LHSB:

© \Vejicie zasilania prad zmienny/prad staly

O \Wejicie VGA

O Wejscie HDMI

O \Wyjscie audio HDMI

© Blokada Kensington zabezpieczenia przed
kradzieza

Potaczenie z komputerem PC

1. Podfacz pewnie przewdd zasilajacy do
ztacza z tylu monitora.

2. Whytacz komputer i odiacz kabel zasilajacy.

Podtacz kable sygnatowe monitora do
ztacza wideo w tylnej czesci komputera.

4. Podtacz kabel zasilajacy komputera i
monitora do pobliskiego gniazda.

5. Wiacz komputer i monitor. Jedli na
monitorze pojawi sie obraz, oznacza to, ze
instalacja zostata zakonczona.



2.2 Dziatanie monitora
El Opis elementéw produktu widocznych z

przodu

Model 227E4QSD, 227E4LSB, 227E4QHSD,
227E4LHSB:

PHILIPS

Model 227E4QHAD, 227E4LHAB:

PHILIPS

A

Bp/v /A 17/4 B/0K [0)

I I [\ I
(7] 6 060 o (1)

(54

(5]
/\ o o WEACZENIE i WYLACZENIE
&/v ©/a F9/4 o/0K 10 zasilania monitora.
é I@ é \9 I. ‘I' O (&)/0K|Dostep do menu OSD.
) < Powrdt do poprzedniego
0| o |WACZENEIWYLACZENE poziomu menu OSD.
zasilania monitora. o 1] |Regulacja gloénosci glodnika.
O /0K |Dostep do menu OSD. © | A V¥ Dopasowanie menu OSD.
o < Powrdét do poprzedniego O ©® Zmianazrédha wejicia sygnatu.
poziomu menu OSD. Smartlmage Lite. Do wyboru
o [H Zmiana formatu Wyéwietlania. o @7 dos‘[epne s3 trzy tryby Standard
© | A ¥V |Dopasowanie menu OSD. (Standardowe), Internet i Game
(Gry).
O © |Zmiana #rddla wejécia sygnatu.
Smartimage Lite. Do wyboru
0 @ dostepne sa trzy tryby: Standard
(Standardowe), Internet i Game
(Gry).




E1 Opis menu ekranowego OSD

Co to jest On-Screen Display (OSD)?

OSD (Menu ekanowe) to funkcja dostepna we
wszystkich monitorach LCD Philips. Umozliwia
ona regulacje przez uzytkownika parametréw
wyswietlania ekranu lub bezposredni wybdr
funkgji monitoréw w oknie instrukgji ekranowych.
Przyjazny dla uzytkownika interfejs ekranowy jest
pokazany ponizej:

Model 227E4QSD, 227E4LSB:

0SD Settings

anguag

Podstawowe i proste instrukcje dotyczace
przyciskow sterowania

W pokazanym wyzej OSD, mozna nacisnac
przyciski ¥ A na panelu przednim monitora w
celu przesunigcia kursora i nacisna¢ przycisk OK
w celu potwierdzenia lub zmiany.

Menu OSD

Ponizej zamieszczony jest widok ogdlny
struktury menu ekranowego OSD. Mozna
go wykorzystac jako punkt odniesienia przy
pdzniejszym wykonywaniu réznych regulacji.
Main menu Sub menu

— Input — VGA

F— DVI (available for selective models)

— HDMI (available for selective models)

— Picture r— Picture Format —— Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
— SmartResponse —— Off, Fast, Faster, Fastest
(available for selective models)
—— SmartContrast — On, Off
— Pixel Orbiting — On, Off
— Over Sacn — On, Off
(available for selective models)
— Audio — Volume — 0~100
(available for selective models)
— Stand-Alone — On, Off
— Mute — On, Off
— Color r— Color Temperature ~ — 500K, 9300K
— sRGB
“— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuit, fEfH1 3, Tiirkge

— OSD Settings — Horizontal — 0~100
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time Out — 5s,10s, 20s, 30s, 60s
— Setup — Auto
t— H.Position — 0~100
— V.Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — O, Off
r— Reset — Yes,No
L— Information



El Powiadomienie o rozdzielczosci

Ten monitor zapewnia optymalne dziatanie w
oryginalnej rozdzielczosci 1920 x 1080@60Hz.
Po uruchomieniu monitora przy innej
rozdzielczoéci, na ekranie zostanie wys$wietlony
komunikat alarmu: Use 1920x1080@60Hz for
best results (Dla uzyskania najlepszych wynikéw
nalezy uzy¢ rozdzielczosci 1920x1080@60Hz).

Alarm dotyczacy wyswietlania w innej
rozdzielczosci niz rozdzielczos¢ oryginalna,
mozna wytaczy¢ w menu Ustawienia OSD
(menu ekranowe).

B Funkcje fizyczne
Nachylanie




3. Optymalizacja obrazu

3.1 Smartlmage Lite
El Co tojest?

Funkcja Smartlmage Lite udostepnia ustawienia
wstepne optymalizujace obraz dla réznego
rodzaju tresci, dynamicznie dostosowujac jasnos¢,
kontrast, kolor i ostro$¢ w czasie rzeczywistym.
Niezaleznie od pracy z aplikacjami tekstowymi,
wyswietlania obrazéw czy ogladania filmdw,
funkcja Smartimage Lite Philips zapewnia
doskonate, zoptymalizowane dziatanie monitora.

Ed Dlaczego jest mi to potrzebne?

Wymagany jest monitor zapewniajacy
zoptymalizowane wyswietlanie wszystkich
ulubionych rodzajéw tresci, a oprogramowanie
Smartlmage Lite dynamicznie dostosowuje
jasnos¢, kontrast, kolor i ostro$¢ w czasie
rzeczywistym w celu poprawy wrazen podczas
ogladania obrazu na monitorze.

E Jak to dziata?

Smartimage Lite to zastrzezona, wiodaca
technologia firmy Philips analizujaca wyswietlane
na ekranie tresci. Na podstawie wybranego
scenariusza funkcja Smartimage Lite dynamicznie
poprawia kontrast, nasycenie koloréw oraz ostro$¢
obrazdw, poprawiajac wyglad wyswietlanych
elementdw - a wszystko to w czasie rzeczywistym,
po nacisnigciu jednego przycisku.

B Jak whaczy¢ funkcje Smartlmage Lite?

ED

1. Nacisnij BD w celu uruchomienia na ekranie
wyswietlacza funkeji Smartlmage Lite;

2. Kontynuuj naciskanie B w celu przefaczenia
pomiedzy Standard (Standardowe), Internet,
Game (Gry).

3. Funkcja Smartimage Lite ekranu pozostanie
widoczna na ekranie przez 5 sekund lub w
celu potwierdzenia mozna takze nacisna¢
przycisk OK.

4. Po wiaczeniu Smartlmage Lite, zostanie
automatycznie wytaczony schemat sRGB.
W celu uzycia sSRGB nalezy wytaczy¢
Smartlmage Lite przyciskiem na panelu
przednim monitora.

Oprécz przewijania za pomoca przycisku B

,mozna takze nacisna¢ przyciski v A w celu

dokonania wyboru i nacisna¢ przycisk OK w

celu potwierdzenia oraz zamkniecia menu OSD

Smartlmage Lite.

Do wyboru dostepne sa trzy tryby: Standard
(Standardowy), Internet, Game (Gry).

@ SmartImage™

Standard

Internet

Game

» Standard (Standardowy): Uwydatnia tekst i
obniza jasno$¢ w celu zwigkszenia czytelnosci
i zmniejszenia zmeczenia oczu. Tryb ten
Znaczaco poprawia czytelnos¢ i wydajnosé
podczas pracy z arkuszami kalkulacyjnymi,
plikami PDF, zeskanowanymi artykutami lub
innymi ogdlnymi aplikacjami biurowymi.

* Internet: Ten profil taczy nasycenie kolordw,
dynamiczny kontrast i poprawe ostrosci w
celu wyswietlania zdjec i innych obrazéw
ze znakomita przejrzystoscia i w zywych
kolorach - wszystko to bez artefaktdw i
wyblaktych kolordw.

*  Game (Gry):Wiacz obwdd over drive dla
uzyskania najlepszego czasu odpowiedzi,
zmniejszenia drzenia krawedzi szybko
poruszajacych sie po ekranie obiektow,
poprawienia wspétczynnika kontrastu dla
jasnego i ciemnego schematu, ten profil
zapewnia najlepsze mozliwosci dla graczy.



3.2 SmartContrast

El Co tojest?

Wyjatkowa technologia dynamicznie analizujaca
wyswietlane tresci i automatycznie optymalizujaca
wspotczynnik kontrastu monitora LCD

dla uzyskania maksymalnej przejrzystosci i
odpowiedniego widoku, zmieniajaca stopniowo
podséwietlenie dla uzyskania bardziej czystych,
wyraznych i janiejszych obrazéw lub
przyciemnienia dla uzyskania wyraznych obrazéw
na ciemnych ttach.

E1 Dlaczego jest mi to potrzebne?

Wymagana jest najlepsza klarowno$¢ wizualna

i komfort podczas ogladania wszystkich

rodzajéw tresci. SmartContrast dynamicznie
reguluje kontrast i dostosowuje podéwietlenie

w celu uzyskania wyraznych, czystych, jasnych
obrazdéw podczas gier lub ogladania filmdw albo
wyraznego, czytelnego tekstu przy pracy biurowe;.
Zmniejszenie zuzycia energii monitora zapewnia
oszczednos$¢ pieniedzy | wydtuzenie zywotnosci
monitora.

E Jak to dziata?

Po uaktywnieniu funkgji SmartContrast, analizuje
ona wyswietlang zawarto$¢ w czasie rzeczywistym
w celu dostosowania kolordw i intensywnosci
podéwietlenia. Funkgja ta dynamicznie poprawia
kontrast, zapewniajac doskonaty jako$¢ podczas
ogladania video lub podczas gier.

3.3 Philips SmartControl Lite

Nowy program SmartControl Lite Phillips
umozliwia sterowanie monitorem poprzez

fatwy w uzyciu graficzny interfejs ekranowy.
Skomplikowane regulacje to przeszto$¢, poniewaz
to przyjazne dla uzytkownika oprogramowanie,
prowadzi uzytkownika przez procedury doktadnej
regulacji rozdzielczosci, kalibracji koloréw, regulacji
zegaralfazy, regulacji RGB punktu bieli, itd.

Wyposazone w najnowsza technologie algorytmu
jadra zapewniajaca szybkie przetwarzanie i
uzyskiwanie odpowiedzi, zgodne z Windows 7,
przyciagajace wzrok dzigki animowanej ikonie
oprogramowanie, moze poprawi¢ doznania
podczas ogladania obrazu na monitorach Philips!

10

El Instalacja

*  Wykonaj instrukcje i dokoncz instalacje.

*  Uruchomienie mozna wykona¢ po
zakonczeniu instalacji.

* W celu pdzniejszego uruchomienia nalezy
klikna¢ ikong skrétu na pulpicie lub na pasku
narzedzi.

Kreator pierwszego uruchomienia

* Po pierwszej instalacji oprogramowania
SmartControl Lite nastapi automatyczne
wyswietlenie kreatora pierwszego
uruchomienia.

*  Kreator krok po kroku przeprowadzi przez
czynnosci regulacji monitora.

* W celu pézniejszego uruchomienia kreatora
mozna takze przej$¢ do menu Plug-in
(Dodatki Plug-in).

» Dalsze opcje mozna dostosowac
bez kreatora, poprzez okno Standard
(Standardowe).



F1 Uruchomienie w oknie Standard

(Standardowe):

Menu Adjust (Dostosuj):

Menu Adjust (Dostosuj) umozliwia
dostosowanie ustawien, takich jak
Brightness (Jasnos¢), Contrast (Kontrast),
Focus (Ostros¢), Position (Potozenie) i
Resolution (Rozdzielczo$¢).

Nalezy postepowad zgodnie z instru kcjami
i wykonac¢ regulacje.

Cancel (Anuluj) powoduje wyswietlenie
pytania o anulowanie instalacji.
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Menu Color (Kolor):

Menu Color (Kolor) umozliwia
dostosowanie ustawien, takich jak RGB, Black
Level (Poziom czerni), White Point (Punkt
bieli), Color Calibration (Kalibracja koloréw)
i Smartlmage Lite (nalezy sprawdzi¢ czes¢
Smartimage Lite).

Nalezy postepowac zgodnie z instru kcjami i
wykonad regulacje.

Sprawdz w tabeli ponizej okreslony element
podmenu.

Przyktad funkcji Color Calibration (Kalibracja
koloréw):

12

"Show Me" (Pokaz) uruchamia samouczek
kalibracji kolordw.

Start - uruchamia 6-krokowa sekwencje
kalibracji koloréw.

Quick View (Szybki podglad) umozliwia
fadowanie obrazéw przed/po zmianie.
Aby powrdci¢ do gtdéwnego okna Color
(Kolor) nalezy klikna¢ przycisk Cancel
(Anuluj).

Funkcja Enable color calibration (Wihacz
kalibracje kolordéw) jest wiaczona domyslnie.
Jedli nie jest zaznaczona, uniemozliwia
wykonanie kalibracji kolordw, a przyciski
startu i szybkiego podgladu sa wyszarzone.
Na ekranie kalibracji musza znajdowac sie
informacje patentowe.



Pierwszy ekran kalibracji koloréw: Menu Options>Preferences (Opcje>Preferencje)
- Bedzie aktywne wylacznie po wybraniu pozydji
Preferences (Preferencje) z menu rozwijanego
Options (Opcje). Dla monitordw bez obstugi DDC/
Cl dostepne sa wyfacznie zakfadki Help (Pomoc) i
Options (Opgje).

*  Przycisk Previous (Poprzedni) jest wytlaczony
do momentu wyswietlenia drugiego ekranu
kolordw.

*  Next (Nastepny) umozliwia przejscie do
kolejnego ustawienia (6 ustawien).

» Z ostatniego ustawienia mozna przejé¢ do
okna File>Presets (Plik>Ustawienia wstepne).

*  Cancel (Anuluj) umozliwia zamkniecie
interfejsu uzytkownika i powrdt do strony
dodatkdw plug-in.

* Wyswietlanie biezacych ien pref
Smartimage Lice yéwietlanie biezacych ustawien preferencji

*  Zaznaczone pole wyboru wiacza funkgje. Pole

Umozliwia zmiang ustawien w celu uzyskania wyboru jest przelacznikiem.

lepszych ustawier wyswietlania, w zaleznosci od

Zawartodci. *  Domyslnie na pulpicie wiaczona jest opcja
Enable Context Menu (Wiacz menu

Po ustawieniu Entertainment (Rozrywka), wiaczane kontekstowe). Enable Context Menu (Wiacz

sg funkcje SmartContrast i SmartResponse. menu kontekstowe) daje mozliwo$¢ wyboru

SmartControl Lite dla opcji Select Preset
(Wybierz ustawienia wstepne) i Tune Display
(Dostosuj ekran), w menu kontekstowym,
dostepnym po kliknieciu pulpitu prawym
przyciskiem myszy. Wylaczenie, powoduje
usuniecie SmartControl Lite z menu
kontekstowego wyswietlanego po kliknieciu
prawym przyciskiem myszy.

*  Domyslnie zaznaczona (Wiaczona) jest
ikona Enable Task Tray (Wiacz pasek zadan).
Enable Context Menu (Wiaczenie menu
kontekstowego) wyswietla menu paska
zadan programu SmartControl Lite. Klikniecie
prawym przyciskiem myszy ikony paska
zadan, powoduje wyswietlenie opcji menu
Help (Pomoc), Technical Support (Pomoc
techniczna), Check for Update (Sprawdz
uaktualnienia), About (Informacje) i Exit
(Zakonicz). Po wytaczeniu Enable Task Tray
Menu (menu paska zadan), ikona paska zadan
wyswietla¢ bedzie wylacznie opcje EXIT
(Zakonhcz).
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* Domyslnie zaznaczona jest (Wiaczona)
opcja Run at Startup (Wiacz przy
uruchamianiu systemu). Po jej wytaczeniu
program SmartControl Lite nie bedzie
uruchamiany przy starcie systemu, ani nie
bedzie pokazywany na pasku zadan. Program
SmartControl Lite mozna wtedy uruchomic¢
jedynie za pomoca skrétu na pulpicie
lub poprzez plik programu. Po usunieciu
zaznaczenia (wyfaczeniu) tego pola wyboru,
nie zostanie zatadowane przy starcie zadne
wstepne ustawienie.

* Wiaczenie trybu przezroczystosci (Windows
7, Vista, XP). Domysélna wartos¢ to 0%
nieprzezroczystosci.

Menu Options>Input (Opcje>Wejicie) - Bedzie

aktywne wyfacznie po wybraniu Input (Wejscie) z

menu rozwijanego Options (Opcje). Dla monitoréw

bez obstugi DDC/CI dostepne sa wytacznie zaktadki

Help (Pomoc) i Options (Opcje). Wszystkie

inne zakfadki programu SmartControl Lite nie sa

dostepne.

* Wyswietlanie panela instrukgji Source
(Zrédto) i biezacych ustawien zrddta wejscia.

* W monitorach z pojedynczym wejsciem okno
to nie jest wyswietlane.

Options (Opcje)>Audio - Zostanie uaktywnione
wylacznie po wybraniu Audio z rozwijanego menu
Options (Opcje).

Dla monitoréw bez obstugi DDC/CI dostepne sa

wylacznie zakladki Help (Pomoc) i Options (Opcje).

Menu Help>User Manual (Pomoc>Podrecznik
uzytkownika) - Bedzie aktywne wyfacznie po
wybraniu User Manual (Podrecznik uzytkownika) z
menu rozwijanego Help (Pomoc). Dla monitoréw
bez obstugi DDC/CI dostepne sa wytacznie zaktadki
Help (Pomoc) i Options (Opcje).

Menu Help>Version (Pomoc>Wersja) - Bedzie
aktwyne wylacznie po wybraniu pozycji Version
(Wersja) z menu rozwijanego Help (Pomoc). Dla
monitoréw bez obstugi DDC/CI dostepne sa
wylacznie zakladki Help (Pomoc) i Options (Opcje).



Menu Context Sensitive (kontekstowe)

Menu Context Sensitive (kontekstowe) jest
domyslnie wiaczone. Po zaznaczeniu pola wyboru
Enable Context Menu (Wiacz menu kontekstowe)
w oknie Options>Preferences (Opcje>Preferencje)
menu to bedzie widoczne.

Context Menu (Menu kontekstowe) zawiera

cztery elementy:

*  SmartControl Lite - Po wybraniu wyswietlane
jest okno About (Informacje) o ekranie.

»  Select Preset (Wybierz ustawienia wstepne)
- Udostepnia hierarchiczne menu zapisanych
ustawien wstepnych do natychmiastowego
wykorzystania. Znak zaznaczenia wskazuje
aktualnie wybrane ustawienie wstepne. Za
pomoca menu rozwijanego mozna takze
uzyska¢ dostep do opcji Factory Preset
(Wstepne ustawienia fabryczne).

*  Dostosuj ekran - Otwiera panel sterowania
SmartControl Lite.

*  Smartlmage Lite - Sprawdz aktualne
ustawienia, Standard (Standardowe), Internet,
Game (Gry).

Wihaczone menu paska zadan

Menu paska zadah mozna wyswietli¢ po kliknigciu
prawym przyciskiem myszy ikony SmartControl
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Lite na pasku zadan. Klikniecie lewym przyciskiem
myszy spowoduje uruchomienie aplikacji.

Menu paska zadan zawiera pie¢ elementéw:

*  Help (Pomoc) - Dostep do pliku User Manual
(podrecznika uzytkownika): Otwiera plik User
Manual (podrecznika uzytkownika) w oknie
domyslnej przegladarki.

»  Technical Support (Pomoc techniczna) -
wyswietla strone pomocy technicznej.

*  Check for Update (Sprawdz aktualizacje) -
przenosi uzytkownika na strone PDI Landing
i sprawdza wersje uzytkownika w odniesieniu
do najbardziej aktualnej, dostepnej wersji.

* About (Informacje) - Wyswietla szczegdtowe
informacje o produkcie: wersja produktu,
informacje o wydaniu i nazwa produktu.

*  Exit (Zakoncz) - Zamknigcie programu
SmartControl Lite.

W celu ponownego uruchomienia SmartControl

Lite, wybierz SmartControl Lite z menu Program,

kliknij dwukrotnie ikong komputera desktop PC

lub uruchom ponownie system.

PHILIPS

Wytaczone menu paska zadan

Po wytaczeniu paska zadan w folderze preferendji
dostepna jest tylko opcja EXIT (Zakoncz). Aby
catkowicie usuna¢ program SmartControl Lite z
paska zadan, nalezy wyfaczy¢ ustawienie Run at
Startup (Whacz przy uruchamianiu systemu) w
Options>Preferences (Opcje>Preferencje).



4. Dane techniczne

227E4QSD, 227E4QHAD, 227E4QHSD:

Typ panela monitora IPS-LCD
Podiwietlenie LED

Rozmiar panela 21,5" W (54,6cm)
Wspétczynnik propordii 16:9

Podziatka pikseli 0,248 x 0,248 mm
Jasnosc 250 cd/m?
SmartContrast 20,000,000:1
Wspétczynnik kontrastu (typowy) 1000:1

Czas odpowiedzi (typowy) 14ms
SmartResponse (dla wybranych

modeli) ’ ( e /ms

Optymalna rozdzielczo$¢ 1920x1080@60Hz

Kat widzenia

178° (w poziomie)/178° (w pionie) przy C/R > 10

Poprawianie obrazu

Smartlmage Lite

Wejscie sygnatu

Kolory wyswietlacza 16,7 M
Czestotliwos¢ odswiezania w pionie | 56Hz - 76Hz
Czestotliwos¢ pozioma 30kHz - 83kHz
sRGB TAK

227E4QSD:VGA (Analogowy), DVI (Cyfrowy)
227E4QHAD, 227E4QHSD:VGA (Analogowy), HDMI

(Cyfrowy)

Wejscie/wyjscie audio

227E4QHAD :Wejscie audio PC, wyjscie stuchawkowe
227E4QHSD :Wyjscie audio HDMI

Sygnat wejscia

Separate Sync, Sync on Green

227E4LSB, 227E4LHAB, 227E4LHSB:

Typ panela monitora TFT LCD
Podswietlenie LED

Rozmiar panela 21,5" W (54,6cm)
Wspdtczynnik proporgji 16:9

Podziatka pikseli 0,248 x 0,248 mm
Jasnos¢ 250 cd/m?
SmartContrast 20,000,000:1
Wspdtczynnik kontrastu (typowy) 1000:1

Czas odpowiedzi (typowy) 5ms
SmartResponse (dla wybranych I

modeli)

Optymalna rozdzielczo$¢ 1920x1080@60Hz
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Kat widzenia

170° (w poziomie) / 160° (w pionie) przy C/R > 10

Poprawianie obrazu

Smartlmage Lite

Wejscie sygnatu

Kolory wyswietlacza 16,7 M
Czestotliwos¢ odswiezania w pionie | 56Hz - 76Hz
Czestotliwos¢ pozioma 30kHz - 83kHz
sRGB TAK

227EA4LSB:VGA (Analogowy), DVI (Cyfrowy)
227E4LHAB, 227E4LHSB:VGA (Analogowy), HDMI

(Cyfrowy)

Wejscie/wyjscie audio

227E4LHSB :Wyjscie audio HDMI
227E4ALHAB :Wejscie audio PC, wyjscie stuchawkowe

Sygnat wejscia

Separate Sync, Sync on Green

Udogodnienia uzytkownika

227E4QSD, 227EALSB, 227E4QHSD, 227E4LHSB:

/v ©/A /< /0K »
227E4QHAD, 227E4LHAB:
&/v ©/A 10/ 4 /0K [0)

Jezyki OSD

Angielski, Francuski, Niemiecki, Hiszpariski, VWW4oski, Rosyjski,
Uproszczony Chinski, Portugalski, Turecki

Inne udogodnienia

Blokada Kensington

Zgodnos¢ ze standardem Plug and
Play

DDC/CI, sRGB, Windows 7/Vista/XE Mac OSX, Linux

Nachylanie -5°/ +20°
227E4QSD:
Tryb whaczenia 30,7W (typ.)
Uspienie (typ.) 0,5W
Wik, (typ.) 0,3W
Wskaznik LED zasilania Tryb wiaczenia: Biate, tryb gotowosci/uspienia: Biate (migajace)
Zasilacz Zewnetrzne, 100-240V, 50-60Hz
227E4QHAD:
Tryb wiaczenia 321W (typ.)
Uspienie (typ.) 0,5W
Wik (typ.) 0,3W
Wskaznik LED zasilania Tryb wiaczenia: Biate, tryb gotowosci/uspienia: Biate (migajace)
Zasilacz Zewnetrzne, 100-240V, 50-60Hz
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227E4QHSD :

Tryb wiaczenia

321W (typ.), 38,5W (maks.)

Uspienie (typ.) 0,5W
Wik (typ.) 0,3W
Wskaznik LED zasilania Tryb wiaczenia: Biate, tryb gotowosci/uspienia: Biate (migajace)
Zasilacz Zewnetrzne, 100-240V, 50-60Hz
227E4LSB:
Tryb wiaczenia 192W (typ.)
Uspienie (typ.) 0,5W
Wik (typ.) 0,3W
Wskaznik LED zasilania Tryb wiaczenia: Biate, tryb gotowosci/uspienia: Biate (migajace)
Zasilacz Zewnetrzne, 100-240V, 50-60Hz
227E4LHAB:

Tryb wiaczenia

19.2W (typ.), 27.9W (maks.)

Uspienie (typ.) 0,5W
Wik (typ.) 0,3W
Wskaznik LED zasilania Tryb wiaczenia: Biate, tryb gotowosci/uspienia: Biate (migajace)
Zasilacz Zewnetrzne, 100-240V, 50-60Hz
227E4LHSB:
Tryb wiaczenia 19,2W (typ.)
Uspienie (typ.) 0,5W
Wik, (typ.) 0,3W
Wskaznik LED zasilania Tryb wiaczenia: Biate, tryb gotowosci/udpienia: Biate (migajace)
Zasilacz Zewnetrzne, 100-240V, 50-60Hz

Produkt z podstawa (S x W x G)

510,0 x 398 x 179 mm

Produkt bez podstawy

510,0 x 314 x 37 mm

(SxW x G)

Produkt z podstawa 2,2 kg
Produkt bez podstawy 1,83 kg
Produkt z opakowaniem 3,738 kg




Zakres temperatury (dziafanie)

0°C do 40 °C

Zakres temperatury

-20°C do 60°C

(Brak dziatania)
Wilgotno$¢ wzgledna 20% do 80%
MTBF 30.000 godz.

ROHS TAK
EPEAT Silver (www.epeat.net)
Opakowanie W 100% nadajace si¢ do przetworzenia

Specyficzne substancje

Obudowa w 100% z PCV, bez BFR

Energy Star

Certyfikaty

Kolor

TAK

Znak CE, FCC klasa B, GOAST, SEMKO, TCO Certified, UL/cUL,
BSMI, 1S09241-307

Czarny/Burgund lub inne opcje koloréw dostepne w danym
regionie

Wykonczenie

Z potyskiem

© Uwaga

1. Certyfikat EPEAT Gold lub Silver jest wazny wyfacznie po zarejestrowaniu produktu przez Philips.
Informacje o stanie rejestracji w danym kraju, mozna uzyska¢ pod adresem www.epeat.net.

N

Dane te moga zosta¢ zmienione bez powiadomienia. Przejdz do www.philips.com/support w celu
pobrania najnowszej wersji ulotki.
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4.1 Rozdzielczos¢ i tryby ustawien
wstepnych

El Maksymalna rozdzielczos¢
1920x1080@60Hz (wejscie analogowe)
1920x1080@60Hz (wejscie cyfrowe)

Fl Zalecana rozdzielczosé
1920x1080@60Hz (wejscie cyfrowe)

3147 720x400 70,09
3147 640x480 59,94
35,00 640x480 66,67
37,86 640x480 72,81
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
63,89 1280x1024 60,02
79,98 1280x1024 75,03
55,94 1440x900 59,89
70,64 1440x900 74,98
65,29 1680x1050 59,95
67,50 1920x1080 60,00
€& Uwaga

Nalezy pamieta¢, ze wyswietlacz dziata najlepiej
w oryginalnej rozdzielczosci 1920x1080@60Hz.
Dla uzyskania najlepszej jakosci wyswietlania
nalezy zastosowac sie do zalecer dotyczacych
rozdzielczosci.
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5. Zarzadzanie zasilaniem

Jesli karta graficzna obstuguje standard VESA
DPM lub jedli zainstalowano w komputerze
odpowiednie oprogramowanie, monitor moze
automatycznie zmniejsza¢ zuzycie energii, gdy
nie jest uzywany. Po wykryciu sygnatu wejscia

z klawiatury, myszy lub innego urzadzenia
wejécia, praca monitora zostanie automatycznie
wznowiona. W tabeli ponizej przedstawiono
zuzycie energii i sygnalizowanie funkgji
automatycznego oszczedzania energii:

227E4LSB:

Synch. | Synch. Keller
Tryb VESA | Wideo "l L "7 | Zuzytaenergia | wskaznika
poz. | pion. LED
Aktywny | WA Tak Tak 19.2W (typ.) Biaty
i A A Biaty
U Wyt | N N 05 W (typ. o
Spienie % ie ie (typ) (migajacy)
Wyfaczony | Wik - - 03 W (typ.) Wik
227E4LHAB:

Synch. | Synch. Kellor
227E4QSD: Tryb VESA | Wideo ;oz.' gion.' Zuzyta energia wsl[zllzz'gika
T o |

Synch. | Synch. el ’ .
Tryb VESA | Wideo : . | Zuzytaenergia | wskaznika L, . . Bi:

4 poz. | pion. Zyta 8 LED Uspienie | Wyt Nie Nie 05W (typ.) (migI:Jch)
Aktywny Wh Tak Tak 30,7 W (typ.) Biaty Wyfaczony | Wik - - 03 W (typ.) Wik
Uspienie | Wyt Nie Nie 05W (typ.) .Bia.h/

G5 227E4LHSB:
| oelids zaadzria zaslamiem |
227E4QHAD: Kellor

Q T VESA [ietes|| TR || S0 | Zusin cramn || wdesta
poz. | pion.
Aktywny | Wh | Tak | Tak | 192W (typ) Bialy
Synch. | Synch. 7 izlzorka
Tryb VESA | Wideo B Uzyta energia | wskazni L ) ' Biaty
poz. | pion. LED Uspienie | Wyt | Nie Nie 05W (typ.) (FvEE)
Aktywny WHh Tak Tak 321W (typ.) Biaty Whtaczony | Wik - - 03W (typ.) Wit

L : ' Bialy

Uspienie | Wyt Nie Nie 0,5W (typ. - . . . .
2 » ®P) | (migajacy) W celu pomiaru zuzycia energii tego monitora
Wykaczony | Wik | - - 03W (typ) Wt nalezy wykona¢ nastgpujace ustawienia.
*  Oryginalna rozdzielczoé¢: 1920x1080
227E4QHSD: 78
[ Defrica mradzamazasniem |1
e Jasnos¢ 250 nitdw
Synch. | Synch. Kellar
HEVESR |Wikes || U | S || ZBiEcige || wiita * Temperatura barwowa: 6500k z petnym
: : LED .
wzorcem bieli
321W (typ) )
Aktywny [ Wk Tak Tak 385W (make) Biaty e Uwaga
Uspienie | Wyt | Nie | Nie [ 05W (typ) (miBgi;ch) Dane te moga zosta¢ zmienione bez
powiadomienia.
Whytaczony | Wit = = 03 W (typ.) Wit
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6. Informacje o przepisach

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased

carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

For displays with glossy bezels the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
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and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

*  Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

*  Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[u Technology for you and the planet
CERTIFIED


www.tcodevelopment.com

EPEAT

(www.epeat.net)

(%  The EPEAT (Electronic
Qe' Product Environmental
7 Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

*  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

* EN55024:2010 (Immunity requirement of
Information Technology Equipment).

»  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

*  2006/95/EC (Low Voltage Directive).

* 2004/108/EC (EMC Directive).

* 2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption)

And is produced by a manufacturing

organization on ISO9000 level.

e 1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

* MPR-Il (MPR1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

e TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.
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Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.
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Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RBAZEARERZIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 year.

SNote

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Serwis i gwarancja

7.1 Zasady firmy Philips dotyczace
defektu pikseli monitoréw z
ptaskim panelem

Firma Philips stara si¢ dostarcza¢ najwyzszej jakosci
produkty. Wykorzystujemy niektére najbardziej
zaawansowane, przemystowe procesy produkgji

i surowa kontrole jakosci. Mimo to czasami nie
mozna unikna¢ defektéw pikseli lub subpikseli
paneli TFT monitordéw, stosowanych w monitorach
7 ptaskim panelem. Zaden producent nie moze
zagwarantowad, wykluczenia defektu pikseli

ze wszystkich paneli, firma Philips gwarantuje
natomiast, ze kazdy monitor w ktdrym stwierdzi
sie niedopuszczalng ilo$¢ defektdw, zostanie
naprawiony lub wymieniony w ramach gwarandji.
Niniejsza informacja objasnia rézne rodzaje defektu
pikseli i definiuje dopuszczalng iloé¢ defektow

dla kazdego ich rodzaju. Aby panel TFT monitora
zostat zakwalifikowany do naprawy lub wymiany

w ramach gwarandji, ilo$¢ wystepujacych w nim
defektow pikseli musi przekracza¢ dopuszczalne
normy. Na przyktad, nie moze by¢ uszkodzonych
wiecej niz 0,0004% podpikseli monitora. Poza

tym, poniewaz niektére rodzaje lub kombinacje
defektéw pikseli sa zdecydowanie bardzie
zauwazalne, Philips ustanawia dla nich jeszcze
wyzsze normy jako$ciowe. Zasada ta obowiazuje
na catym $wiecie.

podpiksel

R G B i
piksel

Piksele i subpiksele

Piksel lub inaczej element obrazu, sktada sie z
trzech subpikseli w kolorach podstawowych:
czerwonym, zielonym i niebieskim. Wiele pikseli
tworzy razem obraz. Gdy $wiecg wszystkie
subpiksele danego piksela, trzy kolorowe subpiksele
wygladaja jak pojedynczy biaty piksel. Kiedy
wszystkie subpiksele s ciemne, trzy kolorowe
subpiksele wygladaja jak pojedynczy czarny piksel.

Inne kombinacje $wiecacych i ciemnych subpikseli
wygladaja jak pojedyncze piksele o analogicznych
kolorach.

Rodzaje defektow pikseli

Defekty pikseli i subpikseli objawiaja si¢ na ekranie
w rézny sposéb. Istnieja dwie kategorie defektdw
pikseli, a kazda z nich obejmuje kilka rodzajow
defektéw subpikseli.

Defekty jasnych plamek

Defekty jasnych plamek objawiaja sie w taki sposdb,
jakby piksele lub subpiksele stale $wiecity lub byty
“wigczone”. Jasna plamka to subpiksel widoczny

na ekranie, gdy monitor wyswietla ciemny wzédr.
Mozna wyrdzni¢ nastepujace typy defektdw jasnych
plamek.

Jeden Swiecacy czerwony, zielony lub niebieski
subpiksel.

| ¢

Dwa sasiednie $wiecace subpiksele:

- Czerwony + niebieski = purpurowy

- Czerwony + zielony = zétty

- Zielony + niebieski = btekitny (jasnoniebieski)

Trzy sasiednie $wiecace subpiksele (jeden biaty
piksel).
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Czerwona lub niebieska jasna plamka jest
jasniejsza o wiecej niz 50 procent od sasiednich
plamek, a zielona jasna plamka jest o 30 procent
jasniejsza od sasiednich plamek.

Defekty czarnych plamek

Defekty czarnych plamek objawiaja sie w taki
sposodb, jakby piksele lub subpiksele stale byty
ciemne lub ‘wyfaczone'. Ciemna plamka to
widoczny na ekranie subpiksel, gdy monitor
wyswietla jasny wzdr. Mozna wyrdznic
nastepujace typy defektéw czarnych plamek.

Bliskos¢ defektow pikseli

Poniewaz moga by¢ bardziej zauwazalne
defekty pikseli i subpikseli tego samego rodzaju,
znajdujace sie niedaleko siebie, firma Philips
okresla réwniez tolerancje bliskosci defektow
pikseli.

Tolerancje defektu pikseli

Aby panel TFT monitora zostat zakwalifikowany
w okresie gwarancyjnym do naprawy lub
wymiany z powodu defektdw pikseli, musza

w nim wystapi¢ defekty pikseli przekraczajace
tolerancje podane w ponizszych tabelach.

DEFEKTY JASNYCH PLAMEK DOPUSZCZALNY POZIOM
1 Swiecacy subpiksel 3
2 sasiednie Swiecace subpiksele 1
3 sasiednie Swiecace subpiksele (jeden biaty) 0
Odlegtos¢ pomiedzy dwoma defektami jasnej plamki* >15mm
taczna liczba defektdw jasnych plamek wszystkich rodzajow 3
DEFEKTY CZARNYCH PLAMEK DOPUSZCZALNY POZIOM
1 ciemny subpiksel 5 lub mniej
2 sgsiadujace ciemne subpiksele 2 lub mniej
3 sasiadujace ciemne subpiksele 0
Odlegtos¢ pomiedzy defektami dwdch czarnych plamek® >15mm
taczna liczba defektow ciemnych plamek wszystkich rodzajéw 5 lub mniej
EACZNA LICZBA DEFEKTOW PLAMEK DOPUSZCZALNY POZIOM
La(czn.a,hczba defektdw jasnych i ciemnych plamek wszystkich 5 s e
rodzajow

€& Uwaga

1. Defekty 1 lub 2 sasiadujacych subpikseli = 1 defekt plamki

2. Ten monitor jest zgodny ze standardem 1SO9241-307 (1ISO9241-307:Wymagania dotyczace
ergonomii, metody testéw zgodnosci i analizy dla elektronicznych wyswietlaczy wizualnych)




7.2 Serwis i gwarancja

Szczegdtowe informacje dotyczace zakresu dziafania gwarancji i dodatkowego wsparcia w danym
regionie, mozna uzyskac¢ na stronie sieci web, pod adresem www.philips.com/support. Kontaktowac sie
mozna takze pod podanym ponizej lokalnym numerem obstugi klienta Philips.

Informacje kontaktowe dla regionu Europy Zachodniej:

Kraj ASC Numer obstugi klienta Cena
Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
[taly A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Informacje kontaktowe dla EUROPY CENTRALNE] I WSCHODNIEJ:

Centrum

obstugi
telefonicznej

Numer obstugi klienta

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
s f‘egm NA KimTec do.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
Ukeaine NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
R NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Informacje kontaktowe dla AMERYKI LACINSKIEJ:

Brazil

Argentina

Centrum obstugi telefonicznej

Vermont

Numer obstugi klienta
0800-7254101

0800 3330 856

Informacje kontaktowe dla Chiny:

Chiny

Numer obstugi klienta: 4008 800 008

USA.

Informacje kontaktowe dla AMERYKI POLNOCNE]:

Centrum
obstugi

telefonicznej

EPI - e-center

ASC

Qwantech

Numer obstugi klienta

(877) 835-1838

Canada

Supercom

Supercom

(800) 479-6696
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Informacje kontaktowe dla regionu APMEA:

Centrum

obstugi

Numer obstugi klienta

telefonicznej

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. Macau:Tel: (853)-0800-987
: Tel:1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
Indonesia NA PT. Gadingsari elektronika Prima Tel: 62 21 75909053, 75909056,
7511530
South Korea [ NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
United Arab {5 AL SHAHD COMPUTER LL.C | 00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA C Ltd +84 5113.562666 Danang City
S +84 5113.562666 Can tho Province
- ‘ (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d.istributor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747,9127592
& Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992

buy-out)
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8. Rozwiazywanie
problemow i FAQ

8.1 Rozwiazywanie probleméw

Na stronie tej omdéwiono problemy, ktére moze
naprawi¢ uzytkownik. Jesli problem utrzymuje sie
po wyprébowaniu przedstawionych rozwiazan,
nalezy skontaktowac sie z przedstawicielem
dziatu obstugi klienta firmy Philips.

E Typowe problemy
Brak obrazu (nie $wieci dioda LED zasilania)
*  Upewnij sig, ze przewdd zasilajacy jest

podtaczony do gniazdka elektrycznego, a
jego drugi koniec do ztacza z tytlu monitora.

*  Upewnij sie najpierw, ze przycisk zasilania
na panelu przednim monitora znajduje sie
w pozycji Wylaczenia, a nastepnie nacisnij
go do pozycji Wiaczenia.

Brak obrazu (Biaty kolor diody LED zasilania)

*  Upewnij sig, ze komputer jest wiaczony.

e Upewnij sig, ze kabel sygnatowy jest
prawidtowo podtaczony do komputera.

*  Upewnij sig, ze nie sa wygiete szpilki ztacza
kabla monitora od strony ztacza. Jedli tak,
napraw lub wymien kabel.

*  Moze by¢ aktywna funkcja oszczedzania
energii.

Na ekranie pojawi sie komunikat

Attention

Check cable connection

*  Upewnij sig, ze kabel monitora jest
prawidtowo podtaczony do komputera.
(Odnosi sie takze do Instrukgji szybkiego
uruchomienia).

*  Sprawdz, czy nie sa wygiete szpilki ztacza
kabla monitora.

*  Upewnijj sig, ze komputer jest wiaczony.
Nie dziata przycisk AUTO

*  Funkgja ustawier automatycznych
jest dostepna tylko w VGA-Analog
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(analogowym trybie VGA). Jesli wynik nie
bedzie satysfakcjonujacy nalezy wykonac
regulacje recznie, przez menu OSD.
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Funkcja Auto nie ma zastosowania w trybie
DVI-Digital (cyfrowym DVI), poniewaz nie jest
tam potrzebna.

Widoczne znaki dymu lub iskrzenia

* Nie nalezy wykonywa¢ zadnych czynnosci
rozwiazywania problemdw

* Dla bezpieczenstwa nalezy natychmiast
odtaczy¢ monitor od zasilania sieciowego

*  Nalezy jak najszybciej skontaktowac sie z
przedstawicielem obstugi klienta Philips.

Bl Problemy zwiazane z obrazem

Obraz nie jest wysrodkowany

*  Nalezy wyregulowaé pozycje obrazu,
poprzez funkcje "Auto" w gtdwnym menu
OsD.

*  Nalezy wyregulowaé pozycje obrazu
poprzez funkcje Phase/Clock (Faza/Zegar)
w menu Setup (Ustawienia) gtéwnego

menu OSD. Dotyczy to wyfacznie trybu
VGA.

Drzenie obrazu na ekranie

*  Nalezy sprawdzi¢, czy kabel sygnatowy jest
prawidtowo i pewnie podtaczony do karty
graficznej lub do komputera PC.

Pojawia si¢ pionowe miganie

*  Nalezy wyregulowac obraz, poprzez funkcje
"Auto” w gldwnym menu OSD.

* Nalezy usunac pionowe pasy poprzez
funkcje Phase/Clock (Faza/Zegar) w menu
Setup (Ustawienia) gtdéwnego menu OSD.
Dotyczy to wyfacznie trybu VGA.

Pojawia sie poziome miganie

*  Nalezy wyregulowac obraz, poprzez funkcje
"Auto” w gldwnym menu OSD.




*  Nalezy usunac pionowe pasy poprzez
funkcje Phase/Clock (Faza/Zegar) w menu
Setup (Ustawienia) gtdwnego menu OSD.
Dotyczy to wyfacznie trybu VGA.

Obraz jest rozmyty, nieostry lub zbyt ciemny

*  Nalezy wyregulowad kontrast i jasno$c¢
poprzez menu ekranowe.

Po wylaczeniu zasilania na ekranie pozostaje
"powidok", "wypalenie" obrazu lub "poobraz"

*  Wydiluzone nieprzerwane wys$wietlanie
statych lub nieruchomych obrazéw, moze
spowodowac na ekranie "wypalenie", znane
réwniez jako "powidok" lub "poobraz".
"Wypalenie", "poobraz" lub "powidok"
to dobrze znane zjawisko dotyczace
technologii LCD. W wigkszosci przypadkdw,
"wypalenie" lub "powidok" albo "poobraz"
znika stopniowo po pewnym czasie od
wylaczenia zasilania.

* Po pozostawieniu monitora bez nadzoru
nalezy zawsze uaktywnia¢ program
wygaszacza ekranu z ruchomym obrazem.

» Jedli na ekranie monitora LCD wyswietlane
sa niezmieniajace si¢ tresci nalezy
zawsze uruchamia¢ aplikacje okresowo
odéwiezajaca ekran.

*  Nie uaktywnianie wygaszacza ekranu
lub aplikacji okresowego odéwiezania
ekranu, moze spowodowac powazne
symptomy “wypalenia” lub “poobrazu”
albo “powidoku”, ktére nie znikna i nie
mozna bedzie ich naprawi¢. Wspomniane
uszkodzenie nie podlega gwarandji.

Obraz jest znieksztatcony. Tekst jest

niewyrazny lub rozmyty.

»  Ustaw tryb rozdzielczosci wyswietlania
komputera PC zgodnie z zalecang
oryginalng rozdzielczoscig ekranu monitora.

Na ekranie pojawiaja sig zielone, czerwone,
niebieskie, ciemne i biate punkty

»  Utrzymujace sie punkty to normalna cecha
ciektych krysztatéw, wykorzystywanych
we wspdtczesnych rozwigzaniach
technologicznych. Szczegdtowe informacje
znajduja sie w czgsci dotyczacej zasad
postepowania z uszkodzeniami pikseli.

Za silne, przeszkadzajace $wiatto "wiaczenia
zasilania"

o Swiatlo diody ,,wtaczonego zasilania” mozna
dostosowac za pomoca ustawien diody
LED zasilania w menu Ustawienia menu
gtéwnego OSD.

W celu uzyskania dalszej pomocy nalezy
sprawdzic¢ liste Punkty informacji klienta i
skontaktowac sie z przedstawicielem dziatu
obstugi klienta firmy Philips.

8.2 SmartControl Lite - FAQ

P1. Po zmianie monitora komputera na inny
nie dziata program SmartControl Lite.
Co nalezy zrobic?

Odp.: Uruchom ponownie komputer PC i
sprawdz, czy dziata program SmartControl
Lite.W przeciwnym razie nalezy usunac
i ponownie zainstalowa¢ program
SmartControl Lite w celu instalacji
wiasciwego sterownika.

P2. Program SmartControl Lite dziatat
weczesniej prawidtowo, ale teraz nie
dziafa, co nalezy zrobic?

Odp.:Jesli wykonane zostaty podane ponizej
czynnosci, moze by¢ konieczna ponowna
instalacja sterownika monitora.

*  Zmien karte graficzna wideo na inna.
»  Zaktualizuj sterownik wideo.

»  Uaktualnij system operacyjny, tzn. zainstaluj
dodatek Service Pack lub poprawke

*  Uruchom ustuge Windows Update i
zaktualizuj monitor i/lub sterownik wideo.

*  System Windows zostat uruchomiony przy
wytaczonym lub odtaczonym monitorze.

* W celu sprawdzenia kliknij prawym
przyciskiem myszy ikone My Computer
(Mdj komputer) i kliknij kolejno Properties
(Wihasciwosci)->Hardware (Sprzet)-
>Device Manager (Menedzer urzadzen).

* Jedli w opcji Monitor widoczna bedzie
pozycja ,,Plug and Play Monitor (Monitor
Plug and Play)”, konieczna bedzie ponowna
instalacja. Wystarczy usunaé program
SmartControl Lite i zainstalowaé ponownie.



P3.

Odp.:

P4.

Odp.:

P5.

Odp.:

Po instalacji programu SmartControl
Lite, klikniecie zaktadki SmartControl
Lite, nie pokazuje niczego lub pokazuje
komunikat btedu, jaka jest przyczyna?
Karta graficzna moze nie by¢ zgodna z
funkcja SmartControl Lite. Jesli marka
karty graficznej jest jedna z wymienionych
powyzej, nalezy sprobowac pobrac
najnowszy sterownik karty graficznej z
witryny sieci Web danej firmy.

Zainstaluj sterownik. Usu SmartControl
Lite, a nastepnie zainstaluj jeszcze raz.
Jesli nadal nie dziata oznacza to, ze karta
graficzna nie jest obstugiwana. Odwiedz
strong sieci web Philips i sprawdz, czy
jest dostepny zaktualizowany sterownik
SmartControl Lite.

Po kliknieciu Product Information
(Informacje o produkcie) wyswietlana
jest tylko ich czes¢. Co sig stato?
Sterownik karty graficznej moze nie by¢
zaktualizowany do najnowszej wersji,

w petni obstugujacej interfejs DDC/CI.
Sprébuj pobra¢ najnowszy sterownik karty
graficznej ze strony sieci Web danej firmy.
Zainstaluj sterownik. Usuit SmartControl
Lite a nastepnie zainstaluj jeszcze raz.

Attention

Theft mode enabled

Zapomniatem kod PIN funkgji Theft
Deterrence (Odstraszanie ztodziei). Co
nalezy zrobi¢?

Centrum serwisowe Philips ma prawo
prosi¢ o identyfikacje i autoryzacje w celu
ustalenia wiasnosci monitora.

Nalezy pamietac, ze funkcja zabezpieczenia
przez kradzieza jest udostepniana jako
wygodna, bezpfatna opcja. Za zarzadzanie
numerami PIN ponosi odpowiedzialnoé¢
indywidualny uzytkownik lub ustalajaca

je organizacja. Po zagubieniu numeru

PIN, punkt serwisowy Philips moze, po
weryfikacji cztonkostwa, ustawi¢ go dla
uzytkownika ponownie, za nominalna
optata. Nalezy pamigta¢, Ze dziafanie to
nie jest objete warunkami gwarancji.
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8.3 Ogodlne pytania FAQ

P1:

Co nalezy zrobi¢, jesli podczas instalacji
monitora na ekranie pojawia si¢
komunikat ,,Cannot display this video
mode” (Nie mozna wyswietli¢ tego
trybu wideo)?

Odp.: Zalecana rozdzielczo$¢ dla tego monitora:

P2:

Odp.:

1920x1080@60Hz.

Odtacz wszystkie kable, a nastgpnie podtacz
komputer do uprzednio uzywanego
monitora.

W menu Start systemu Windows wybierz
kolejno polecenia Settings/Control

Panel (Ustawienia/Panel sterowania). W
oknie Panel sterowania wybierz ikong
Display (Ekran).W panelu sterowania
Display (ekranu) wybierz karte ,,Settings
(Ustawienia)". W zaktadce ustawien, w polu
'desktop area (obszar pulpitu)' przesun
suwak na 1920x1080 pikseli.

Otwdrz okno ,,Advanced Properties
(Wihasciwosci zaawansowane)” i wybierz dla
ustawienia Czestotliwos¢ odswiezania opcje
60 Hz, a nastepnie kliknij przycisk OK.
Uruchom ponownie komputer oraz
powtdrz czynnosci 2 1 3 w celu
sprawdzenia, czy rozdzielczo$¢ komputera
PC jest ustawiona na 1920x1080@60Hz.

Whytacz komputer; odtacz stary monitor i
podtacz monitor LCD Philips.

Wiacz monitor, a nastepnie wiacz komputer.

Czym jest zalecana czgstotliwosé
odswiezania dla monitora LCD?
Zalecana czestotliwo$¢ odswiezania

dla monitoréw LCD wynosi 60 Hz. W
przypadku jakichkolwiek zaktdcer obrazu
mozna ustawi¢ czestotliwos$¢ 75 Hz w
celu sprawdzenia, czy wyeliminuje to
zaktdcenia.



P3:

Odp.:

P4:

Odp.:

P5:

Odp.:

Pé:

Odp.:

P7:

Odp.

Do czego stuzg pliki .inf oraz .icm
znajdujace si¢ na dysku CD-ROM? Jak
zainstalowac sterowniki (.inf oraz .icm)?
Sa to pliki sterownika monitora. Aby
zainstalowac sterowniki, nalezy wykonac
instrukcje z podrecznika uzytkownika.
Podczas pierwszej instalacji monitora
moze zosta¢ wyswietlony monit
komputera dotyczacy sterownikéw
monitora (pliki .inf oraz .icm) lub dysku
sterownika. Nalezy postepowac zgodnie z
instrukcjami w celu wioZenia dotaczonego
do zestawu dysku CD-ROM. Sterowniki
monitora (pliki .inf oraz .icm) zostana
zainstalowane automatycznie.

Jak wyregulowac¢ rozdzielczos¢?

Na dostepne rozdzielczosci maja wptyw
karta video/sterownik graficzny i monitor.
Zadana rozdzielczoéé mozna wybra¢ w
oknie Windows® Control Panel (Panela
sterowania systemu Windows®) poprzez
“Display properties (Wtasciwosci
ekranu)”.

Co nalezy zrobi¢ w przypadku pomylenia
sie podczas regulacji ustawien monitora,
przez menu OSD?

W celu przywrdcenia wszystkich
poczatkowych ustawien fabrycznych,
wystarczy nacisnac przycisk OK, a
nastepnie wybrac¢ 'Reset (Resetuj)".

Czy ekran LCD jest odporny ma
zarysowanial

Ogdlnie zaleca sig, aby powierzchnia
ekranu nie byfa poddawana nadmiernym
wstrzasom i byta chroniona przed ostrymi
lub tepymi przedmiotami. Podczas
przenoszenia monitora nalezy upewnic¢
sig, ze na powierzchnie ekranu nie jest
wywierany zaden nacisk ani nie dziata
Zadna sita. Moze to mie¢ wptyw na
warunki gwarancji.

Jak nalezy czysci¢ powierzchnie ekranu
LCD?

:Do zwyldego czyszczenia nalezy

uzywac czystej, migkkiej szmatki. Do
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rozszerzonego czyszczenia nalezy uzywac
alkoholu izopropylowego. Nie wolno
uzywac innych rozpuszczalnikéw, takich jak
alkohol etylowy, etanol, aceton, heksan itp.

P8: Czy mozna zmieni¢ ustawienie kolorow
monitora?

Odp.: Tak, ustawienie koloréw mozna zmienic¢
w menu OSD, wedtug nastepujacych
procedur,

*  Naciénij "OK", aby wyswietli¢ menu OSD
(Menu ekranowe)

*  Nacisnij "Down Arrow" (strzatke w ddt), aby
wybra¢ opcje "Color" (Kolor), a nastepnie
naciénij "OK", aby przejé¢ do ustawienia
koloréw, dostepne sa trzy pokazane ponizej
ustawienia.

1. ColorTemperature (Temperatura
koloréw): Przy ustawieniach z zakresu
6500K wyswietlany obraz jest ciepty,

z odcieniem czerwono-biatym; a przy
temperaturze 9300K obraz jest zimny, z
odcieniem niebiesko-biatym.

2. sRGB:jest to ustawienie standardowe,
zapewniajace prawidtowa wymiane
koloréw miedzy réznymi urzadzeniami
(np. aparaty cyfrowe, monitory, drukarki,
skanery, itp.)

3. User Define (Zdefiniowane przez
uzytkownika): uzytkownik moze
wybraé Zadane ustawienie kolordw,
dostosowujac poziom koloru
czerwonego, zielonego i niebieskiego.

© Uwaga

Pomiar koloru $wiatta emitowanego przez
podgrzewany obiekt. Pomiar ten jest wyrazony
w skali absolutnej (stopnie Kelvina). Nizsze
temperatury Kelvina, takie jak 2004K; oznaczaja
kolor czerwony; wyzsze temperatury, takie jak
9300K, oznaczaja kolor niebieski. Neutralna
temperatura to kolor biaty 6504K.

P9: Czy moge podtaczy¢ moj monitor
LCD do kazdego komputera PC, stacji
roboczej lub komputera Mac?



Odp.: Tak. Wszystkie monitory LCD Philips
sa catkowicie zgodne ze standardami
komputeréw PC, Mac i stacji roboczych.
Do podfaczenia monitora do systemu Mac
moze by¢ konieczna przejSciéwka kabla. W
celu uzyskania dalszych informacji nalezy
skontaktowac sie z przedstawicielem
handlowym firmy Philips.

P10: Czy monitory LCD Philips sa Plug-and-
Play?

Odp.: Tak, monitory te sa zgodne ze standardem
Plug-and-Play w Windows 7/Vista/XP/NT,
Mac OSX i Linux

P11: Co to jest utrwalanie obrazu, wypalanie
obrazu, poobraz lub powidok na
panelach LCD?

Odp.: Wydtuzone nieprzerwane wyswietlanie
statych lub nieruchomych obrazéw, moze
spowodowac na ekranie "wypalenie",
znane réwniez jako "powidok” lub
"poobraz". "Wypalenie", "poobraz" lub
"powidok" to dobrze znane zjawisko
dotyczace technologii LCD. W wiekszosci
przypadkdw, "wypalenie" lub "powidok"
albo "poobraz" znika stopniowo po
pewnym czasie od wylaczenia zasilania.
Po pozostawieniu monitora bez nadzoru
nalezy zawsze uaktywnia¢ program
wygaszacza ekranu z ruchomym obrazem.
Jedli na ekranie monitora LCD
wyswietlane sa niezmieniajace sie tresci
nalezy zawsze uruchamia¢ aplikacje
okresowo odéwiezajaca ekran.

) Ostrzezenie

W powazniejszych przypadkach "wypalenia"

lub "powidoku" albo "poobrazu", symptomy nie
znikajg i nie mozna tego naprawi¢. Wspomniane
powyzej uszkodzenie nie jest objete gwarancja.

P12: Dlaczego tekst na ekranie nie jest
wyrazny, a wyswietlane znaki sa nieostre?
Odp.: Ten monitor LCD dziafa najlepiej
z oryginalna rozdzielczoscia
1920x1080@60Hz. Nalezy ustawic¢ taka
rozdzielczo$¢ w celu uzyskania najlepszego
obrazu.
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